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About this guide

This guide provides setup and basic troubleshooting information for the HP Z1 Workstation. It includes
these topics:

Guide topics

Locating HP resources on page 1

HP Z1 Workstation features on page 7

Setting up and using the workstation on page 11

Setting up and restoring Windows 7 on page 27

Setting up and restoring Windows 8 on page 34

Setting up and restoring Linux on page 39

Updating the workstation on page 44

Diagnostics and Minor Troubleshooting on page 46

Routine Care on page 52

TIP: If you do not find what you are looking for in this guide:

— Find technical details in the HP Z1 Workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

— View removal and replacement videos at http://www.hp.com/go/sml.

— See additional information on your workstation at http://www.hp.com/go/workstations.
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1 Locating HP resources

This section provides information on the following resources for your HP workstation:

Topics

Product information on page 2

● Technical specifications

● HP Cool Tools

● Regulatory information

● Accessories

● System board

● Serial number, Certificate of Authenticity, and Genuine
Microsoft Label

Support on page 3

● Product support

● HP Support Assistant

● Warranty information

Product documentation on page 4

● HP and third-party documentation, white papers

● Product notifications

● Technical specifications (QuickSpecs)

● Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 5

● HP Vision Diagnostics

● Audible beeps and LED code definitions

● POST error codes

Product updates on page 6

● Driver and BIOS updates

● Operating systems
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Product information
Table 1-1  Product information

Topic Location

Technical specifications Go to www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

HP Cool Tools (Windows® 7
only)

Most HP workstations with the Windows 7 operating system are preloaded with tools
that may enhance system performance and with additional software that is not
automatically installed during first boot. To access these applications:

● Click the HP Cool Tools icon on the desktop, or

● Open the HP Cool Tools folder by selecting Start > All Programs > HP >
HP Cool Tools.

To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application icon.

Regulatory information Refer to the Safety & Regulatory Information guide for product regulatory information.
You can also refer to the regulatory label on the workstation chassis.

Accessories For complete and current information on supported accessories and components, see
http://www.hp.com/go/workstations.

System board A diagram of the system board is located on the inside of the chassis (all-in-one
configuration). Additional information is located in the workstation Maintenance and
Service Guide on the Web at http://www.hp.com/support/workstation_manuals/.

Serial number, Certificate of
Authenticity (COA), and Genuine
Microsoft Label (GML) (if
applicable)

The serial number label is on a pull-out card on the side of the display (all-in-one
configuration). The COA (Windows 7) and GML (Windows 8) are typically located
near the serial number label. Some workstations have this label on the bottom panel.

Linux For information on running Linux on HP workstations, go to http://www.hp.com/
linux/, then select Linux on Workstations from the list on the left.
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Support
Table 1-2  Support

Topic Location

Product support For U.S. support, go to http://www.hp.com/go/contactHP.

For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

Here you can:

● Chat online with an HP technician

● Obtain email support

● Find support telephone numbers

● Locate an HP service center

HP Support
Assistant
(Windows 7
only)

HP Support Assistant is an HP application that helps you maintain the performance of your workstation
and resolve problems through automated updates and tune-ups, built-in diagnostics, and guided
assistance.

To access HP Support Assistant, double-click the HP Support Assistant icon on your desktop.

NOTE: HP Support Assistant is preinstalled on select HP workstations running Windows 7. HP
Support Assistant is not available on workstations running Windows 8 or Linux.

Warranty
information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, see http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.

You can find the expressly provided HP Limited Warranty applicable to your product in the start menu
on your PC and/or in the CD/DVD provided in the box. For some countries/regions, a printed HP
Limited Warranty is provided in the box. In countries/regions where the warranty is not provided in
printed format, you may request a printed copy from www.hp.com/go/orderdocuments or write to:

● North America: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA

● Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063,
Cernusco /Naviglio (MI), Italy

● Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

Please include your product number, warranty period (found on your serial number label), name, and
postal address.
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Product documentation
Table 1-3  Product documentation

Topic Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, go to http://www.hp.com/support/
workstation_manuals. These include this User Guide and the Maintenance and
Service Guide.

Removal and replacement videos To learn how to remove and replace workstation components, go to
http://www.hp.com/go/sml.

Product notifications Subscriber's Choice is an HP program that allows you to sign up to receive driver
and software alerts, proactive change notifications (PCNs), the HP newsletter,
customer advisories, and more. Sign up at www.hp.com/united-states/subscribe/
gateway/?jumpid=go/subscribe-gate1.

Technical specifications The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information about the operating system, power supply, memory, CPU, and many
other system components. To access the QuickSpecs, see http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. See http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources section, select See more....

4. Use the scroll bar to select Customer Advisories, Customer Bulletins, or
Customer Notices.
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Product diagnostics
Table 1-4  Product diagnostics

Topic Location

Windows 7 Diagnostics tools The HP Vision Diagnostics utility is preinstalled on select Windows 7 workstations.

Windows 8 Diagnostics tools The HP Vision Diagnostics utility is preinstalled on select Windows 8 workstations.

For additional information, see the workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.

Audible beep and LED code
definitions

Refer to the workstation Maintenance and Service Guide at http://www.hp.com/
support/workstation_manuals.

POST error codes Refer to the workstation Maintenance and Service Guide at http://www.hp.com/
support/workstation_manuals.
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Product updates
Table 1-5  Product updates

Topic Location

Driver and BIOS updates See http://www.hp.com/go/workstationsupport to verify that you have the latest
drivers for the workstation.

To determine the current workstation BIOS on your workstation, follow these steps
during system power up:

1. Power on the workstation, and press Esc during start up (boot).

2. Press F10 to enter the F10 Setup utility.

3. Go to File > System Information. Note the BIOS version and date and
compare it with the BIOS versions that appear on the HP website.

You can also find the BIOS version number in Windows 7:

1. Go to Start > All Programs > Accessories > System Tools > System
Information.

2. In the right pane, find the line with BIOS Version/Date.

3. Note the BIOS version and date and compare it with the versions that appear
on the HP website.

You can also find the BIOS version number in Windows 8:

1. Point to the upper-right or lower-right corner of the Start screen to display the
charms.

2. Click Settings > Change PC Settings.

Operating systems For additional information, on:

● Operating systems supported on HP workstations, go to http://www.hp.com/
go/wsos.

● Windows operating systems, go to http://www.microsoft.com/support.

● Linux operating systems, go to http://www.hp.com/linux.
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2 HP Z1 Workstation features

For complete and current information on supported accessories and components for the workstation,
see http://partsurfer.hp.com.

Components

Front and bottom components

Figure 2-1  Front and bottom components

Table 2-1  Component descriptions

1 Camera angle adjustment dial 5 Serial number pull-out card

2 Camera 6 Speakers

3 Left and right digital microphones 7 Stand

4 Display panel 8 Chassis latches (bottom view)
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Side components

Figure 2-2  Side components

Table 2-2  Component descriptions

1 Power button 6 IEEE-1394a FireWire® connector

2 Hard drive activity light 7 USB 3.0 connectors (2)

3 Slot-load optical drive eject button 8 Headphone connector

4  Slot-load optical drive 9 Microphone connector

5  xD/MMC/MS/SD card reader  
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Rear components

Figure 2-3  Rear components (excluding stand)

Table 2-3  Component descriptions

1  Handle 6  Power cord connector

2 Subwoofer connector (orange) 7 USB 2.0 connectors (4)

3 Audio line-out connector (green) 8 Optical S/PDIF audio output

4 Audio line-in connector (blue) 9 RJ-45 network connector

5 DisplayPort connector 10  Cable lock slot
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Product specifications

Physical characteristics

Table 2-4  Physical characteristics

Weight

With stand 21.3 kg (47.0 lbs)

Without stand 15.4 kg (34.0 lbs)

Stand only 5.9 kg (13.0 lbs)

Dimensions

Upright, excluding stand Height: 584.2 mm (23.0 in)

Width: 660.4 cm (26.0 in)

Depth: 419.1 cm (16.5 in)

Stand only Height: 457.2 cm (18.0 in)

Width: 660.4 cm (26.0 in)

Depth: 81.3 cm (3.2 in)

Environmental specifications

Table 2-5  HP Workstation environmental specifications

Temperature

Operating: 5°C to 35°C (40°F to 95°F)

Non-operating: -40°C to 60°C (-40°F to 140°F)

NOTE: The ambient upper limit of 35°C is good up to 1524 m (5000 ft) elevation. Derate by
1°C for every 305 m (1000 ft) above 1524 m (5000 ft). For example, at 3,048 m (10,000 ft),
the upper ambient air temperature limit is 30°C.

Humidity
Operating: 8% to 85% relative humidity, non-condensing

Non-operating: 8% to 90% relative humidity, non-condensing

Altitude
Operating: 0 to 3,048 m (10,000 ft)

Non-operating: 0 to 9,144 m (30,000 ft)

Shock

Operating: ½-sine: 40g, 2-3ms

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~100g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating random: 0.5g (rms), 5-300 Hz

Non-operating random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.
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3 Setting up and using the
workstation

Topics

Setting up the workstation on page 11

Display options on page 21

Using the webcam on page 25

Installing optional components on page 25

Security on page 25

Product recycling on page 25

Setting up the workstation

Location and ventilation

Proper ventilation for the system is important for workstation operation. To ensure adequate ventilation:

● Operate the workstation on a sturdy, level surface.

● Provide at least:

◦ 12 cm (4.7 in) clearance at the front, back, top, and bottom of the workstation

◦ 16 cm (6.3 in) clearance on the right side for the optical drive

● Ensure that the ambient air temperature surrounding the workstation falls within the specified limits
(see Environmental specifications on page 10).

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes.

Setting up the workstation 11



Setup procedure

1. The HP Z1 Workstation weighs 21.3 kg (47.0 lbs.) and must be removed from the box by two
people.

WARNING! If a product is shipped in packaging marked with this icon , the product must

always be lifted by two people to avoid personal injury due to product weight.

WARNING! To reduce the risk of electric shock or damage to your equipment:

— Plug the power cord into a grounded (earthed) AC power outlet.

— Do not disable the power cord grounding pin (for example, by attaching a two-pin adapter).
The grounding pin is an important safety feature.

— To disconnect power from the workstation, unplug the power cord from the grounded AC
outlet.

2. Push the unit down firmly to the lowest horizontal position to release the green button in the stand.

CAUTION: Never open the unit unless it is in the lowest horizontal position. Otherwise, system
components may be damaged.

Figure 3-1  Push down to release green button

3. Push the green button while lifting.

Figure 3-2  Push the green button
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4. To access the lower I/O ports, carefully tilt the unit backwards, away from you.

Figure 3-3  Tilt the unit away from you to access the lower I/O ports

5. After tilting the unit, connect the power cord, Ethernet cable, and other peripherals, including the
wired keyboard and mouse, to the lower I/O panel.

Route the cables through or around the unit stand.

Figure 3-4  Connect cables to lower I/O panel
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6. When cable connections are complete, carefully tilt the unit forwards, toward you.

Figure 3-5  Tilt the unit towards you after connecting cables

NOTE:  Because the workstation is heavy and the stand joints are tight, you might need to exert
some force to maneuver the workstation.

7. Rotate the workstation to the upright position. Some force is required.

Figure 3-6  Rotate the workstation
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8. Connect the workstation to a grounded AC power outlet (1) and power on the unit (2).

Figure 3-7  Power on the workstation

9. If you order a wireless mouse/keyboard as an after-market option, you can connect the wireless
mouse and wireless keyboard using the following steps.

a. Insert the wireless dongle into a side USB port.

NOTE: You also have the option of installing the wireless dongle in a internal USB port. For
instructions, refer to Installing the USB wireless dongle into the internal USB port
on page 18.

Figure 3-8  Insert dongle in unit side USB port
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b. Turn the wireless mouse switch on.

Figure 3-9  Turn switch on

c. Press the connect button on the dongle for five seconds until the dongle LED blinks.

Figure 3-10  Press the connect button

d. Press the connect button on the wireless mouse to synchronize the wireless signal. Then, if
necessary, press the connect button on the wireless keyboard. To synchronize the wireless
mouse and keyboard, position them less than 30 cm (12 in) from the dongle.

Figure 3-11  Press the connect button on the wireless mouse and keyboard

<30 cm
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10. Connect the unit to the Internet through the wireless feature or with an RJ-45 network cable.

Figure 3-12  Connect to the Internet
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Installing the USB wireless dongle into the internal USB port

If you order a wireless keyboard and mouse as an after-market option, you can install the wireless
dongle in the internal USB port. See the following instructions:

1. Turn off the workstation, and then unplug the power cord from the grounded AC power outlet.

2. Holding the workstation firmly at the center of the top and bottom, maneuver the workstation into a
horizontal position.

Figure 3-13  Maneuver workstation to horizontal position

3. Slide the latches on the bottom of the workstation outward and open the chassis.

Figure 3-14  Open chassis
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4. Install the dongle in the internal USB port on the lower I/O assembly.

Figure 3-15  Internal USB port

IMPORTANT: An outline around the internal USB port identifies the maximum area allowed for
an internal USB device. The dongle must fit within this area.

5. Plug in the power cord and turn on the workstation. Press the connect button on the dongle for five
seconds until the LED on the dongle blinks. Carefully close the workstation and maneuver it to an
upright position.

6. Ensure the mouse and keyboard are within 30 cm (12 in) of the workstation and away from
interference from other devices. Turn on the power on the bottom of the wireless mouse (1). Press
the connect button on the mouse (2) for five seconds, and then press the connect button on the
keyboard (3) for five seconds. Place them in front of the workstation.

Figure 3-16  Activate wireless keyboard and mouse
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Enabling Bluetooth Devices

The workstation is Bluetooth®-enabled. To connect a Bluetooth wireless device:

1. Make your Bluetooth device send out a radio signal so that it is discoverable by the workstation
(refer to the device documentation for instructions).

2. In the Windows Control Panel, go to Hardware and Sound.

● If your Bluetooth device is a printer, click Printers, click Add a printer, and follow the on-
screen instructions.

● For all other devices, click Bluetooth Devices, click Add, and then follow the on-screen
instructions.
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Display options

Adjusting display brightness

The HP Z1 Workstation uses two methods to control the display brightness.

● The backlight brightness settings control the overall brightness of the internal display panel only.

● The pixel color brightness settings control the individual pixel color intensity for the internal display
panel and an external monitor. Changing the pixel color brightness will affect the color of the
pixels and will affect the colors of your display.

Controlling display panel brightness

Internal display panel backlight brightness

Windows 7 and Windows 8 each offer two methods for controlling the backlight brightness of the
internal display panel. These two options adjust the backlight brightness from 100% down to 30% of
the full backlight brightness.

Windows 7

1. Select Control Panel > Power Options.

2. Move the screen brightness slider at the bottom of the window to make adjustments.

– or –

1. Click Start > Programs > Productivity and Tools > HP My Display.

2. Select Adjust.

3. Move the slider to make adjustments.

4. At the bottom of the window, click Apply or OK to save the changes.

Windows 8

1. Point to the upper-right of the Start screen to display the Charms menu.

2. Click Settings.

3. In the lower corner of the right panel, click Brightness.

4. Move the slider to make adjustments.

– or –

1. From the desktop window, point to the task bar at the lower edge of the screen.

2. Click the Show hidden icons arrow then click the HP My Display icon.

3. Select Adjust.

4. Move the slider to make adjustments.

5. At the bottom of the window, click Apply or OK to save the changes.
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Pixel color brightness

Pixel color brightness is controlled with either the Intel® iGFx or the NVIDIA MXM graphics controller
interface. Both controllers can adjust the internal display panel and an external monitor. This adjustment
affects the brightness level of the individual RGB pixels and affects the colors of the pixels.

Intel iGFx adjustments for an internal display panel

1. Right-click a blank area on the display desktop to open the system display control window. Click
Graphics Properties.

2. Select the Advanced radio button, and click OK. The Intel Graphics and Media control panel
opens.

3. From the left side of the Intel Graphics and Media control panel, select Display > Color
Enhancement.

4. Click the Display drop-down window and select Built-In Display.

5. The brightness slider is set to 0%. Move the slider to adjust the brightness up to 100% or down to
–60%.

6. At the bottom of the window, click Apply or OK to save the changes.

Intel iGFx pixel color adjustments for an external monitor

1. Right-click a blank area on the display desktop to open the system display control window. Click
Graphics Properties.

2. Select the Advanced radio button and click OK. The Intel Graphics and Media control panel
window displays.

3. From the left side of the Intel Graphics and Media control panel, select Display > Color
Enhancement.

4. Click the Display drop-down window and select the External Monitor. For example, if a
ZR2740w monitor is connected, select Digital Display ZR2740w.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, click Apply or OK to save the changes.

NVIDIA MXM controller pixel color adjustments for an internal display panel

1. Right-click a blank area on the display desktop to open the system display control window. Click
the NVIDIA control panel.

2. Click the HP Z1 display panel icon. A green box outlines the icon.

3. On the left side of the NVIDIA Control Panel, click Adjust desktop color settings, and select
the internal display panel to adjust.

4. Click the Use NVIDIA Settings radio button.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, click Apply or OK to save the changes.
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NVIDIA MXM controller pixel color adjustments for an external monitor

1. Right-click a blank area on the display desktop to open the system control window. Click the
NVIDIA control panel.

2. Click the icon for your external monitor. A green box outlines the icon.

3. On the left side of the NVIDIA Control Panel, click Adjust desktop color settings, and select
the external monitor to adjust.

4. Click the Use NVIDIA Settings radio button.

5. The brightness slider is set to 50%. Move the slider up or down to adjust the brightness.

6. At the bottom of the window, click Apply or OK to save the changes.

Adding an external monitor

To connect a monitor to the workstation:

1. Determine the correct cable and/or adapter requirements for the monitor:

Monitor Interface Required connection

DisplayPort DisplayPort cable

VGA DisplayPort to VGA adapter with VGA cable

DVI DisplayPort to DVI adapter with DVI-D cable

Dual-Link DVI DisplayPort to DLDVI adapter with Dual-Link
cable

HDMI DisplayPort to HDMI adapter with HDMI cable

2. Connect the DisplayPort end of the cable/adapter to the DisplayPort connector on the back of the
workstation.

3. Connect the other end of the cable to the external monitor.

4. Turn on the monitor. If the workstation is running Microsoft® Windows and a graphics driver is
installed, the workstation automatically detects the external monitor and uses it as a display.

Customizing the display panel or the external monitor

You can manually select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings of the workstation's display panel or external monitor. Use
either the control panel of the graphics processing unit (MXM card or integrated graphics) or select the
Windows Control Panel > Display options.

For more information about customizing your external monitor, refer to the documentation included with
the monitor.
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Using the HP Z1 Workstation as a monitor

The DisplayPort connector on the HP Z1 Workstation is bi-directional and lets you use the workstation
as a display for another computer, such as a laptop. The other computer (referred to as the external
graphics source) must have a graphics DisplayPort output connector.

A set of keystrokes on the workstation keyboard switches the port from output to input and back. While
in output mode, the port drives an external monitor. While in input mode, an external graphics source
drives the workstation display panel.

NOTE: This feature is only supported on the Windows operating system.

To use the workstation as a monitor:

1. Connect one end of a DisplayPort cable to the external graphics source's DisplayPort connector.
Connect the other end to the DisplayPort connector on the back of the HP Z1 Workstation.

Figure 3-17  Connecting the display ports

2. On the HP Z1 Workstation keyboard, simultaneously press Ctrl+Shift+S+D (switch display) to
enable the workstation to display output from the external graphics source.

3. To switch back, simultaneously press Ctrl+Shift+S+D on the HP Z1 Workstation keyboard to
reinstate the internal graphics source and place the workstation display panel in standby mode.
On the HP Z1 Workstation, move the mouse or press the space bar to wake up the display panel.

NOTE: This feature relies on the My Display utility, which is subject to change with new software
and driver releases. To download the latest software and driver, go to http://www.portrait.com/
dtune/hpw/enu/upgrade_instructions.html.
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Adjusting the audio signal
● There is no hardware volume control on the HP Z1 Workstation. (However, some keyboards do

have volume buttons, usually in the upper-right corner.)

● Volume can be adjusted with the operating system (OS) master control or the software (SW) audio
player control.

● The OS master control and SW audio player control are independent. However, they are both
simultaneously active and affect the overall volume of the audio signal.

● If the audio signal is not audible, check the OS master control and SW audio player control to be
sure that neither is set too low.

Using the webcam
The webcam works automatically with any webcam software.

A white activity LED is on when the webcam is active. Optimal performance of the fixed-focus lens is at
0.5 meters.

A dial at the top of the workstation lets you:

● Adjust the camera angle.

● Disable the camera by turning the dial all the way toward the front of the workstation. A red stripe
in the camera viewport indicates the lens is pointing straight down into the chassis. The user is not
visible.

Installing optional components
You can install additional components such as memory, hard drives, and PCIe Mini Cards in your
workstation.

● To view component installation videos, go to http://www.hp.com/go/sml.

● For installation guidelines and technical information, refer to the HP Z1 Workstation Maintenance
and Service Guide at http://www.hp.com/support/workstation_manuals.

Security
You can secure your workstation by attaching a lock to the cable lock slot. The workstation includes
several security features to reduce the risk of theft and to warn of chassis intrusion. Refer to the
Maintenance and Service Guide for information about additional hardware and software security
features available for your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.
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For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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4 Setting up and restoring Windows
7

This chapter provides setup and update information for the Windows 7 operating system. It includes
these topics:

Topics

Setting up the Windows 7 operating system on page 27

Restoring and recovering in Windows 7 on page 28

NOTE: After you set up the operating system, you should make sure the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up the Windows 7 operating system
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the
software.

For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the online help tool after you successfully install
the operating system.

Installing or upgrading device drivers

You must install the appropriate device drivers before you install hardware devices. Follow the
installation instructions that came with the device. For optimum performance, your operating system
must have the most recent updates, patches, and software fixes. For additional driver and software
update information, refer to the chapter on updating the workstation.
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Transferring files and settings

The Windows operating system offers data migration tools that help you select and transfer files and
data from one Windows-based computer to another.

For information on these tools, go to http://www.microsoft.com.

Restoring and recovering in Windows 7
To protect your information from loss or damage, back up your personal data files. Refer to the
operating system or backup utility documentation for instructions on making backup copies of your data
files.

To protect the software from loss or damage, keep a backup copy of all system software, applications,
and related files stored on the hard drive.

If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support. To
obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.
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System Restore

If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:

1. Close all open programs.

2. Click the Start button, right-click Computer, click Properties, and then click System
protection.

3. Under Protection Settings, select the disk for which you want to create a restore point.

4. Click Create, and then follow the on-screen instructions.
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System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery. Always use the System Restore
procedure before you use the System Recovery program. See System Restore on page 29.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 30 or System Recovery when Windows is not responding on page 31.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 31.

System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you have created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 32.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, and then click Recovery Manager. If prompted, click Yes to allow the program
to continue.

5. Under I need help immediately, click System Recovery.

6. Select Yes, and then click Next. Your computer restarts.

NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then click
Next to restart the computer. If you are using discs, insert the next disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files,
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and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

8. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

9. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you have created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, click System Recovery.

6. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

7. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

8. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media

You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the recovery
image stored on your hard disk drive. This image contains the operating system and software program
files that were originally installed on your computer at the factory. You can create only one set of
recovery media for your computer, and the media can be used only with this computer. Store the
recovery media in a safe place.

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.

● To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-R
DL discs to create recovery discs.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.
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● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

Creating recovery media

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a flash drive with a capacity of at least 8 GB.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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Using recovery media

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To create recovery media, see System recovery using recovery media on page 31.

To perform a System Recovery using recovery media:

1. If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2. If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

or

Click the Start button, and then click Shut Down.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer.

5. Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select the
boot menu and press Enter. Use the arrow keys to select the location where the recovery media is
inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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5 Setting up and restoring Windows
8

This chapter provides setup and update information for the Windows 8 operating system. It includes
these topics:

Topics

Additional information on page 34

Backup and recovery in Windows 8 on page 35

NOTE: After you set up the operating system, you should make sure the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Additional information
Additional information is available in the online help after you customize the operating system.

Setting up the Windows 8 Operating System

The first time you turn on the computer you can customize the operating system. If you are connected to
the Internet, Microsoft activates your operating system. This process takes about 15 to 30 minutes.
Carefully read and follow the instructions on the screen.

We recommend that you register your computer with HP; so you can receive important software
updates, facilitate support questions, and sign up for special offers. You can register your computer
with HP using the Register with HP app on the Start screen.

CAUTION: After the initial setup process has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during this process may damage the software
that runs the computer or prevent its proper installation.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type help, and then select Help and Support.
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Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Backup and recovery in Windows 8
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case of
system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type help, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media is used to start up (boot) the computer and repair the
operating system in case of system instability or failure. Your initial and subsequent backups allow you
to restore your data and settings if a failure occurs.

Type backup on the Start screen, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive, or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Backup templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Windows Backup and Restore:
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image, or create system
repair media.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● The F11 recovery tools: You can use the F11 recovery tools to recover your original hard drive
image. The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using HP Windows 8
restore media (purchased separately) on page 38.

Using the Windows recovery tools

To recover information that you previously backed up:

▲ From the Start screen, type help, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type help, and then select Help
and Support.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition:

From the Start screen, type e, and then click Windows Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the Driver
Recovery media (both purchased separately). For additional information, see Using HP Windows
8 restore media (purchased separately) on page 38.
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3. If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.

NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.

4. Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type help, and then select Help
and Support.

Using F11 recovery tools

CAUTION: Using F11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The F11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using F11:

1. If possible, back up all personal files.

2. Restart the computer, and then press esc while the company logo is displayed. The computer
Startup Menu displays.

3. Press F11 to select the System Recovery option.

4. Choose your keyboard localization.

5. On the Choose an option menu, select Troubleshoot.

6. On the Troubleshoot menu, choose either Refresh your PC to repair the OS or Reset your PC
to completely reinstall the OS.

7. Follow the on-screen instructions.

NOTE: If the F11 System Recovery does not start, you must recover your operating system and
programs using the Windows 8 Restore Media (purchased separately). For additional information,
see Using HP Windows 8 restore media (purchased separately) on page 38.
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Using HP Windows 8 restore media (purchased separately)

To order HP Windows 8 restore media, go to http://www.hp.com/support, select your country or
region, and follow the on-screen instructions. You can also order the media by calling support.

CAUTION: Using HP Windows 8 restore media completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using HP Windows 8 restore media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows 8 OS DVD.

3. Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

4. When prompted, press any keyboard key.

5. Follow the on-screen instructions.

After the operating system install is completed:

1. Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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6 Setting up and restoring Linux

HP offers a variety of Linux solutions for HP workstation customers:

● HP certifies and supports Red Hat Enterprise Linux (RHEL) on HP workstations.

● HP certifies and supports SUSE® Linux Enterprise Desktop (SLED) on HP workstations.

● HP offers a SLED 11 preload on some Z series Workstations.

This chapter describes how to set up and restore the Linux® operating system. It includes these topics:

Topics

HP Installer Kit for Linux (HPIKL) on page 40

Setting up Red Hat Enterprise Linux on page 40

Setting up SUSE Linux Enterprise Desktop (SLED) on page 42

Proprietary graphics drivers on page 43

NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software
updates are installed. Refer to the chapter on updating the workstation.

CAUTION: Do not add optional hardware or third-party devices to the workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

HP Linux Support Matrix
Not all release streams are supported on particular platforms. To find out which streams are supported
on your workstation. refer to the Linux certification and support matrix:

1. Go to http://www.hp.com/linux.

2. In the Platforms tab, select HP Workstations.

3. Select Certification Matrix.

4. Go to the Red Hat or SUSE tab.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL or SLED on HP workstations. It
is available as an operating system option on all HP workstations. The kit:

● Contains tested drivers that augment and/or replace those found in RHEL or SLED to enable
proper use and behavior on HP workstations.

● Does not include Linux operating system, which must be purchased separately from Red Hat or
SUSE. To view supported configurations and operating systems, go to http://www.hp.com/
support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution, or who have a licensed version of RHEL or SLED and would like to
install the HP-recommended driver additions.

The kit also can be downloaded:

1. Go to http://www.hp.com/support/workstation_swdrivers.

2. Select your workstation model.

3. Select the desired operating system.

4. Select your software/driver language, then click the Software quick jump link.

5. Click the Obtain Software link for the appropriate package (typically the most recent revision).

6. Click I Agree to accept the terms of the license agreement.

7. Download the software ISO image and save it on a disc. This disk is your HP driver disc.

Setting up Red Hat Enterprise Linux
HP Z series Workstations are certified and supported on RHEL streams appropriate to the hardware
technology.

● For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP
Linux Workstations at http://www.hp.com/support/linux_hardware_matrix.

● For information about Red Hat certifications on HP workstations, go to
https://hardware.redhat.com.
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HPIKL driver disc

Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver disc, which can be used as
a post-installation utility for the standard Red Hat Linux install.

After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs.
After you specify a number of settings (such as the security level, time and date, root password, user
accounts), the utility lets you to load additional disc.

The driver disc is used during this phase. All content added by HP is in the /HP directory on the disc.
You can use it to build your own image or to browse the HP content.

NOTE: Some installations may encounter problems if they are performed with a DisplayPort
connection to the monitor. This is because the default drivers that the OS installers use do not support
DisplayPort functionality. If you experience problems, try overriding the monitor choice for DisplayPort
during the start of the install and using the VESA driver instead. You can then set up the DisplayPort
monitor later.

Installing with the HP Red Hat Linux driver disc

1. If you do not have the appropriate HP driver disc for a supported stream, create one (see HP
Installer Kit for Linux (HPIKL) on page 40.

2. Install the operating system using the optical media included in the Red Hat Linux box-set.

3. If you have a Red Hat driver disk for the OS version you are installing, enter linux dd on the
initial install splash screen, and then press Enter.

4. When asked if you have a driver disc, select Yes. Place the Red Hat driver disc in the drive, and
select the appropriate drive:hd[abcd]. Continue the normal installation.

5. After successfully installing the operating system, reboot the workstation.

● RHEL 5: the Red Hat Setup Agent (also known as first-boot) automatically starts. At the
Additional DVDs screen, insert your HP driver disc and select Install. When the driver
installation task is completed, continue following the prompts until the operating system is
successfully installed.

● RHEL 6: Insert your HP driver disc. The HPIKL installation software automatically starts. Follow
the prompts to install the contents.

Warranty

As part of the HP workstation hardware warranty, HP provides software configuration and installation
support for certified versions of Red Hat Linux for up to 90 days from date of purchase.
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Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series Workstations and supports 64-bit SLED 11 on
other workstations.

Various versions of SLED are certified and supported by SUSE on HP workstations. For more
information, refer to the SUSE certification bulletin search page at http://developer.novell.com/
yessearch.

Setting up preloaded SLED

To set up SLED on systems preloaded with the operating system:

1. Start the workstation.

2. When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.

NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration
screen. To view the full SUSE Customer Center documentation, go to http://www.suse.com/
documentation and select your operating system.

Installing SLED with the DVD Installer Kit

1. If an HP driver disc did not come with your workstation, create one (see HP Installer Kit for Linux
(HPIKL) on page 40.

2. Install the operating system using the discs included in the SUSE box-set.

3. After successfully installing the operating system, reboot the workstation.

4. Insert your HP driver disc. The HPIKL installation software automatically starts. Follow the prompts
to install the contents.

Warranty

HP provides configuration and installation support for SLED 11 on Z series Workstations for up to 90
days from date of purchase. SUSE also provides support for all versions of SLED that are certified on HP
workstations.
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Restoring SLED (preloaded systems only)

The SLED restore media is required to restore the Linux operating system. To create restore media:

1. Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all iso images
used to preload your workstation.

2. Follow the instructions in the readme file in this folder to copy the ISO image file onto optical
media.

3. Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images tor restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the
method and media of your choice.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification
by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware_matrix for a list of supported cards.

NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for
cards that consume large amounts of power in lower-power workstations.

Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 preload on Z series Workstations, and from HP Workstation
Support at http://www.hp.com/go/workstationsupport.

These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are not
open source. Driver revisions more recent than those at the HP support website are supported directly
by the vendor.

Proprietary graphics drivers 43

http://www.hp.com/support/linux_hardware_matrix
http://www.hp.com/support/linux_hardware_matrix
http://www.hp.com/go/workstationsupport


7 Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software
updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 44.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 45.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining the current BIOS version

To determine the current BIOS version:

1. Press Esc during power-up.

2. Press F10 to enter the F10 Setup utility.

3. Select File > System Information. Note the workstation BIOS version and compare it with the
BIOS versions that appear on the HP website.

NOTE: Procedures for upgrading the BIOS, as well as the F10 Computer Setup utility BIOS
Menu settings, are located in the HP Z1 Workstation Maintenance and Service Guide at
http://www.hp.com/support/workstation_manuals.
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Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the website is the same as the version on your system, no further action is required.

5. If the BIOS on the website is a version later than the one on your system, download the
appropriate version for the workstation. Follow the instructions in the release notes to complete the
installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP website to
download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP website first to see if your
device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit
the device manufacturer's website to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Under Tasks in the left column, select Download Drivers and Software.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the website of the manufacturer of the peripheral device.
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8 Diagnostics and Minor
Troubleshooting

Calling support
At times you might encounter an issue that requires support. When you call support:

● Have the computer readily accessible.

● Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example:
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 10-
or 12-digit serial number of the computer.

NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).

For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your
region, and click Connect with HP in the upper-right corner.

46 Chapter 8   Diagnostics and Minor Troubleshooting

http://www.hp.com/support


Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
computer.

● All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

● The Certificate of Authentication (COA) is used only for systems with Windows 7 preinstalled.

● The Genuine Microsoft Label (GML) is used only for systems with Windows 8 preinstalled.

● A service label shows the build ID and Feature Byte strings, which are needed for system board
replacement.

The all-in-one service label can be found in the location shown in Figure 8-1 (pull-out card).

Figure 8-1  All-in-one service label location
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Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, online support, and helpful hints
for troubleshooting.

HP Support Assistant (HPSA)

HP Support Assistant (Windows 7 systems only) helps you maintain workstation performance and
resolve problems. HPSA provides automated updates, onboard diagnostics, product information, and
guided assistance to help maintain optimum workstation performance. To access HPSA, click Start >
All Programs > HP Help and Support > HP Support Assistant.

NOTE: HP Support Assistant is not available on Linux or Windows 8.

Online support

Online access and support resources include web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following websites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

● http://www.hp.com/support—Provides a listing of the worldwide technical support phone
numbers. Access the telephone numbers by visiting the website, then select your region, and click
Contact HP in the upper-left corner.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.
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Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat

HP Instant Support is a set of web-based support tools that automate and speed up the resolution of
problems concerning desktop computing, tape storage, and printing.

Active Chat enables you to electronically submit a support ticket to HP over the web. When you submit
a support ticket, Active Chat collects information about the computer and passes it to an online support
specialist. The collection of information might take up to 30 seconds, depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, go to
http://instantsupport.hp.com/.

NOTE: This feature is not available on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices

To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Resources for <your selected product>, select See more….

4. Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com/
go/workstationsupport.
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Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation is plugged into a functional AC power outlet.

● Remove all optical discs and USB drive keys from the drives before powering on the workstation.

● Verify that the workstation is turned on and the power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the internal display panel is lit.

● If the internal display panel is dim, turn up the brightness.

● If you have an external monitor:

◦ Verify that the monitor is plugged into a functional AC power outlet.

◦ Verify that the monitor is turned on and the green monitor light is on.

◦ If the monitor is dim, turn up the brightness and contrast controls.

During operation

● Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section in the
Maintenance and Service Guide for your workstation for information on interpreting diagnostic
lights and audible codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.
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● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the internal display panel on an all-in-one computer is blank, open the computer and ensure that
both ends of the cable between the system board and the internal display panel are connected. If
using a graphics card, verify that the graphics card is properly installed.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.

Customer Self-Repair program

Under the Customer Self-Repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer Self-Repair might be required for some components. See
http://www.hp.com/go/selfrepair for information on the program.

NOTE: Some components are not eligible for Customer Self-Repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.

Other troubleshooting options

The following additional troubleshooting techniques and tools are located in the Maintenance and
Service Guide at http://www.hp.com/support/workstation_manuals:

● POST Error Codes

● Diagnostic LEDs and audible beep codes

● Troubleshooting scenarios and solutions

● HP Vision Field Diagnostics
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9 Routine Care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the computer.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the computer before cleaning the keyboard, mouse, or air vents.

● Always disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the chassis
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

● After cleaning, always wipe the computer with a clean, lint-free cloth.

● Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

● If the keyboard has an on/off switch, turn it off.

● Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.

CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful
not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a
clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
1. Follow the safety precautions in the Maintenance and Service Guide for your workstation before

cleaning the computer.

2. If the mouse has an on/off switch, turn it off.

3. Wipe the body of the mouse with a damp cloth.

4. If the mouse has a:

● Laser or LED: use a cotton swab dampened with cleaning solution to gently brush out any
dust around the laser or LED, then wipe again with a dry swab. Do not wipe the laser or LED
directly with the swab.

● Scroll wheel: spray canned, pressurized air in the gap between the scroll wheel and the click
buttons. Do not blow air directly on one spot for very long or condensation can form.

● Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out
the socket with a dry cloth, and reassemble the mouse.
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